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Studio Software Update 10.1 – Release Notes 

Previous Studio Release: 10.0.5 
Supported Equipment PC: Z370, Q470, W680 

Recommended PLC Versions (hardware dependent): See details in PLC/HMI Update 
Offline Studio Operating System: Extensive testing specifically performed on Win 10 and Win 11 64 bit 

  

Summary: 

All included Studio applications have been validated for compatibility with previously created Akrometrix Studio 
file formats. Files created prior to Studio 8.0 will not be readily usable with the Automated Report Generator or 
Batch Interface Analysis feature. Important bug fixes and added features are listed below. This list does not include 
all resolved bugs and added features. Known issues are presented with workarounds where applicable. Studio 10 
is built referencing updated external software components, requiring all update procedure steps to be run in order 
to function correctly. 

Update Procedure: 

Install Studio 10.1 from downloads section of Akrometrix website. If updating from a system that has not already been 
updated to Studio 10, follow instructions in Studio 10 release notes to install and configure pre-requisite software packages. 

PLC/HMI Update 

Studio 10.1 requires an update to the PLC for the AXP 2.0, AXP3, and PS600S systems including a PLC (PS600S system 
including an HMI screen seen on the front of the electrical cabinet instead of a Watlow CSL208 temperature controller). 
Owners of any other Akrometrix models may skip this step. Download and use PLC and HMI versions per the table below. 

Instructions for applying PLC/HMI code are available in a separate document. 

Model Equipment Serial Number PLC Version HMI Version 

AXP 2.0 

<0413 1095 

0084 
0413-0440 (except 0433 and 

0437) 
2095 

0433, 0437 and >0440 2508 

AXP3 Any 300A 3008 

PS600S 
<0432 1016 

0084 
>0438 2016 

PS600T Any 4001 3008 

Updating Lens Controllers Through the User Configuration File 

Users with an automated lens will be required to update their user configuration (.xml) file, located in the Surface 
Measurement directory. 

1. Start Surface Measurement software and close it to allow program to modify SM_UserConfiguration.xml file. 

2. Open LensConnect_Windows_GUI_x86_2.2.0.exe at C:\Portable\Computar\Lens Connect\ 

3. In the LensConnect Controller 2.2.0 software, click Scan lens to find the serial number of the controller 

4. Open SM_UserConfiguration.xml using Notepad++ located at C:\Users\Engineer\AppData\Roaming\Akrometrix\ 

5. Update the <CameraLensController> tag entry with the automated lens vendor name, model #, and lens controller 
serial number obtained in step 2. Note that there must be an underscore after the word “Computar” and before the 
serial number in this entry. 

E.g. Computar_VL6Z1626*C-MPYIR_00D99D09 
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Key Feature Changes or Additions: 

Studio 10.1 is releasing without fully updated User Manuals for this version, to be provided at a later date. 

PS600T 

The PS600T supersedes the PS600S, featuring upgrades to the heating, grating loading, and the HMI screen. These 
upgrades now align the PS600 series with the AXP series in both design and performance. The table below shows the key 
differences between the two models. 

 PS600T PS600S 

Heating Top and bottom heating Bottom heating only 

Gratings 
Frameless 

Rests on supports 

Framed 

Support pins secure to lid 

HMI Touchscreen Traditional with physical buttons 

A temperature gradient exists when heating is only applied to the bottom surface of a sample. Introducing top heating 
reduces this gradient and improves temperature uniformity throughout the sample during a temperature profile. While all 
samples benefit from uniform heating, larger samples have a larger gradient. Top heating on the PS600T ensures 
temperature uniformity of large samples, 

On the PS600S, gratings are mounted to the top lid using support pins that pass through a glass-fiber composite frame to 
hold the grating in place. Installing them requires the user to fully open the lid, lean over the oven, and use one hand to 
secure the pins while the other holds the grating steady. In the PS600T, this process has been redesigned for ease of use. 
Users simply open the lid and place a frameless grating onto three support feet, making the install quicker, easier, and more 
ergonomic. 

The HMI is fully interactive, replacing physical buttons and switches with a modern touchscreen interface. Various 
instrument status indicators and thermocouple readings are displayed in real-time. Users can switch the language between 
English, Chinese, Korean, and Japanese. 
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DFP3 Module 

The DFP (Digital Fringe Projection) 3 module has been upgraded with automated functionality and higher-resolution 
projector and camera components. It now includes two lens sets: a prime lens with a 40 x 50 mm FOV, and a variable lens 
offering a FOV range from 80 x 100 mm to 192 x 240 mm. 

 

 

Automation includes moving the camera and projector assembly in and out of the oven using NAVIGATE TO LOAD 
OPTION. This capability makes switching between Shadow Moiré and DFP measurements much easier, as the adjustable 
assembly allows users to transition smoothly between the two techniques 
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The projector can be rotated through NAVIGATE TO ZABER CONTROLS. These adjustments, previously performed 
manually, can now be made through software, allowing for easier operation and small incremental corrections. Prime lenses 
allow presets for aperture and focus to be created, while variable lenses include a zoom-controller attachment that allows 
zoom controls to be included in the presets. These presets help users switch between different fields of view with only a 
few clicks, saving time and improving consistency by enabling a return to the same settings when needed. 

DIC3 Module 

 

The DIC (Digital Image Correlation) 3 module has been upgraded with two sets of higher-resolution cameras, an 
independent light source, and a camera stage to adjust camera height relative to the oven. One set of lenses is positioned 
on the left and right sides, while the other set is located at the front and back. When launching the Surface Measurement 
software, users are prompted to select the camera orientation: Left/Right, Front/Back, or All Cameras. The selected 
orientation determines which cameras are utilized, and those are the only cameras that collect measurement data. 

When Left/Right or Front/Back orientation is selected, the Camera window displays two live images. When All Cameras 
is selected, four live images are displayed. The Lens Controller window displays controls for the corresponding number of 
lens controllers based on the orientation selection. 
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Profile Gauge Editor 

 

There are six new profile gauges available that allow users to set conditions for monitoring heating rates and temperatures:  

- Heating rate between temperatures 

- Cooling rate between temperatures 

- Time above temperature 

- Time between temperatures 

- Peak temperature 

- Peak temperature between times 

Users can assign custom names to these gauges. Results are displayed to either pass or fail and can be configured to stop 
the profile on failure. The pass criteria of the gauges can be selected from the following options: greater than, greater than 
or equal to, less than, less than or equal to, or between specified values. 

 

Profile gauges can also be configured within the Output Settings in the Profile Setup dialog, accessible in Thermal Profiler. 
When profile gauges are enabled, a new panel will appear below the profile table, displaying gauge, user defined name, 
input parameters, passing criteria, and the results with the calculated value. 
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Regions 

Regions can be enabled through the Transform menu in both the Phase and Displacement tabs. This allows filters to be 
applied to specific areas of the phase or displacement data. Multiple regions can be added as needed and can be configured 
to either include or exclude applicable processing steps. Region configurations are saved in *.akx_regions files, which can 
be saved and loaded for convenience. In the advanced settings of Batch Processing, region files can be selected to apply 
processing steps to user defined regions.  

Once the desired regions have been defined, the user may close the Region Manager. Subsequent processing will be 
restricted either within or outside the defined regions, depending on whether Include Regions or Exclude Regions was 
selected. The following filters do not work on only regions: mask, physical size, and grating composition. 
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Surface Brightness Mask 

The surface brightness mask filters data based on grayscale intensity values. This is particularly useful for unpainted 
samples or for excluding areas that are relatively bright or dark. For example, an unpainted BGA can be illuminated to the 
point where the solder balls become satured in brightness, making it easy to isolate and remove the ball regions.  



 

 Page 8 of 13 

 

The Surface Brightness parameter window follows the same layout as other parameter windows in the software. Users can 
define a value range by manually entering the minimum and maximum values, left- or right-clicking on the histogram, or 
choosing a preset range of one, two, or three standard deviations from the dropdown box.  

 

Secondary Interference Removal 

 

In Shadow Moiré measurements, a primary fringe pattern is generated by the interference between the grating lines and 
the shadows they cast on a sample surface. Certain repetitive features on the surface can produce an additional, secondary 
interference pattern. This can sometimes be mitigated by rotating the sample relative to the grating lines or by painting the 
surface. 

However, some users may prefer not to alter their samples or may only notice the secondary pattern after running a thermal 
profile. A new post-processing option has been introduced to address this, Remove Secondary Interference. This feature 
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reduces rippling caused by secondary interference patterns by subtracting a best-fit sine function from each row or column, 
depending on the direction of the ripple. 

Users can: 

• Select the direction of the ripple (horizontal or vertical). 

• Adjust the kernel size to improve how accurately the sine function fits the observed ripple pattern. Larger kernel 
sizes may be needed for surfaces with many features. 

 

New Gauges 

- 3SP warpage: Calculates same numerical value as 3S warpage, but forces the transition results to be positive 

- 3SP warpage DB: Calculates same numerical value as 3S DB warpage, but forces the transition results to be positive 

- 3SN warpage: Calculates same numerical value as 3S warpage, but forces the transition results to be negative 

- 3SN warpage DB: Calculates same numerical value as 3S warpage DB, but forces the transition results to be negative 

- Point Gauge: Determine z-value at user specified point(s). Support for both individual displacement files and batch 
processing. Tables and plots for each point are available in reports. The point gauges can also be added to Color 
Contour, 2D Disp Image, and Surface Image. 

  

New Shortcuts 

- Partitions and masks can be rotated by one-degree adjustments using the Shift + left/right arrow keys 

- Cycling through the surface image, phase images, and gray code (if applicable) can be done using PgUp/PgDn or the 
numpad ‘+’ and ‘-‘ keys 

- The use of the ‘0’, ‘-‘, and ‘=’ keys extend the intensity views to a maximum of 12 

- The first 6 DFP gray code images can be accessed using QWERTY 

- When a region has been defined in the Z-Range parameters window, it can be shifted to the left or the right by holding 
the CTRL key and clicking to the left or the right of the region 
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Studio 10.1 Features: 

- Surface Measurement: 

o Start up checks upon opening of software 

▪ A PC power configuration check. If Surface Measurement is run as administrator, power settings will 
auto-configure, else a dialog box will warn user 

▪ Windows ‘Language for non-Unicode programs’ is set to ‘English (United States)’ 

▪ Windows decimal symbol is set to ‘dot’ 

▪ Video card and its current driver support OpenGL 

o Regions of interest can now be rotated increasing region selection flexibility 

o Lens controller options have been removed from the Camera Control window and placed in a new window, 
titled Lens Control, accessible through the Window menu 

o Easy access to Akrometrix Optical Techniques and Analyses 101 document through the Help menu 

o DFP 

▪ A progression bar appears when the projector is going through its initial configuration upon opening 
Surface Measurement 

▪ .akx_disp files save faster 

o DIC 

▪ Left and right cameras can now be zoomed independently 

▪ Added intensity values for the left and right cameras 

▪ Added focus controls to the Lens Control Window to assist with camera focusing 

▪ Target dot information has been added to display the number of dots and average pixels per dot  

▪ Background color added to Camera windows 

- Thermal Profiler: 

o Customize profile table by hiding or adding information columns 

o Sample position check if stages have been homed: profile start is blocked if the stage limit is tripped or position 
is below 25 mils, and a warning appears if position is above 2000 mils 

o Profile gauge results are available on a table below the profile table. Only visible when gauges are enabled 

▪ Profiles without preprogrammed gauges can be configured in the profile setup dialog 

o Added ProfileRuntime, TemperatureReading, TemperatureNominal, and TemperatureSetpoint metadata tags 
support to naming template 

o Verifies AXP3 and PS600T sliding doors are closed before profile start 

o Profile outputs (.txt and .png) are now auto saved. Profile complete dialog is displayed upon completion of 
profile and Profile stop dialog when user stops profile 
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- Surface Analysis 

o The phase amplitude threshold now displays a histogram to assist with value selection. Rounding has been 
refined so that 0% is shown only when no points are selected, and 100% is shown only when all points are 
selected. For very small values that would have previously rounded down to 0%, less than 0.01% is displayed. 
Similarly, for very large values that would have previously rounded up to 100%, greater than 99.99% is 
displayed 

 

o Partitions and masks can now be rotated for more flexible region selection. Rotation occurs by dragging the 
green dot above the selected region or editing the region and manually entering an angle 

 

 

o Added contour lines feature for 2D and 3D plots. Available in output options for Batch Processing and 
Automated Report Generator  

 

o Can now add directory file path by ‘Add from clipboard’, ‘Add from specific…’, and ‘Add from parent…’ in both Batch 
Processing and Automated Report Generator 

o Increased the number of recent files list from 4 to 10 
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o Easy access to Akrometrix Optical Techniques and Analyses 101 document through the Help menu 

o Z Legend visibility and position can be adjusted either in the displacement image or adjusting the default settings in the 
Options 

o Z Legend can be adjusted to set the lowest z-value to 0 without applying a plane rotation by using the new Subtract-
Minimum transform feature, which is also available for batch processing in the Advanced filter list 

o Displacement data can now be saved in .csv format 

o Surface image is an output options for reports 

o Added <CurrentDateTime> metadata tag that inserts the report’s current date and time 

o Removed Phase tab from displacement files 

o Batch Processing 

▪ Added surface brightness mask to the Advanced filter list and batch mask 

▪ Added 3SP warpage, 3SP warpage DB, 3SN warpage, and 3SN warpage DB gauges 

▪ Added range and standard deviation values in summary table and implemented alternating row colors 

▪ Remove filename extension due to redundancy  

o Metadata Updater 

▪ The update button now disabled when the Edit Group window first opens. The number of modified files 
is shown in parentheses on the button 

▪ An asterisk appears at the end of the file name in the first column for any file that has been modified 

▪ After editing a cell with a number in it, users can enable the Auto Increment feature to apply the same 
format to each cell below, updating only the number in sequence through the rest of the list 

▪ The New Roi Name column is highlighted yellow instead of the Roi Name Converter column to improve 
readability 

- License Utility 

o When applying an update to a key, users are notified if the selected file does not contain any updated 
information 

 

Key Bug Fixes: 

- Surface Measurement: 

o Square bounds feature now applies to multiple selected ROIs 

o Ethernet cameras do not lose communication after opening Surface Analysis for the TTSM or PS200 

- Thermal Profiler: 

o Optimized sub-room module column list for the AXP 2 and AXP 3  

o Fixed a startup error that occurred when launching a new profile after stopping a previous one with a sample 
height of 0 

o Resolved an issue when assigning the ‘Output Path Template’ to an existing directory caused a setup error if 
the ‘Filename Template’ specified a subfolder 

- Surface Analysis: 

o Setting chord to outside of image boundary now snaps starting/ending positions to image edge 

o Disabled relative adjustment of phase amplitude threshold on displacement data within batch processing 

o Surface and intensity images are now saved with files created through batch processing feature detection 

o Gauges/Output Tabs window now opens for duplicated displacement files 

o Resolved issues with using database files as source within File Finder 
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o ROC, DTA, and SS use proper formatting and decimal places 

o Can no longer mask all data within phase or displacement images and cannot partition a region with no data 

o Partitioning a region that intersects with a masked region now honors masked region 

o Custom *.akx_chordset files can now be applied to displacement images  

o Adjusted user entered range for Temperature Nominal metadata value to be -75 to 500 

o Updated z unit precision on chord plots: 2 decimal for mils and 1 decimal for microns 

o Improved consistency between 3D and chord plots shown in Batch Interface Analysis preview and reports  

o Batch Processing 

▪ Resolved formatting issue with last column of results when analyzing less than 14 files  

▪ Metadata column width adjusted to match summary table 

▪ Physical dimensions recorded in Batch Results.txt 

▪ Custom smooth filter in Advanced Analysis Settings now editable when loading *.akx_recipe file 

o Automated Report Generator 

▪ Scroll bar does not disappear when navigating back to Groups tab when adding six or more locations 
to Folder List 

▪ Resolved issue with building database while using filename filter  

▪ Tabs within currently loaded MDDDL files are recognized 

▪ Removing gauge plots from reports can now be done after generating a report with gauge plots 

▪ Default report settings are now loaded when entering Automatic Report Generator through Batch 
Processing 

▪ Reports maintain the specified order of Output Options list from the Layout Settings tab 

Known Issues 

- No further known issues are reported at this time. 

Versions (listed for reference): 

Studio Manager  10.0.22227 

SurfaceMeasurement 10.0.22227 

SurfaceAnalysis  10.1.22227 

ProfileGenerator 10.0.22227 

LicenseUtility  10.0.22227 

User Manuals Studio Studio 9.0 


